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Level TROLL® 400, 500, 700, and 700H

A serial (RS232) TROLL Com is required for use
with a RuggedReader Handheld PC.

Connecting the RuggedCable System
Connect the Instrument to the RuggedCable
System
1. Remove the protective caps from the instrument and
cable. Ensure that the O-ring on the instrument
connection is clean.

Connect TROLL Com Communication Device to
the RuggedCable System
1. If a desiccant is present, remove the desiccant from the
cable. Hold the textured section of the cable connector in
one hand and the desiccant in the other. Twist in
opposite directions to unlock the desiccant from the
cable.

2. Locate the flat side of each connector and notice the pins
on the instrument connector and the slots on the cable
connector.
2. Position the TROLL Com and the cable flat edges so
they will connect properly. Insert the TROLL Com
connector firmly into the cable connector.

In order to deploy the instrument, complete the following
steps.
l

l

l

l

l

3. Slide back the sleeve on the cable connector.

Connect the instrument to a computer or
RuggedReader.
Connect the instrument to the software and set up a
site and a data log.
Install the instrument in the water. (If you are using a
level reference set it at this time.)

4. Position the instrument and cable flat edges so they will
connect properly. Insert the instrument connector firmly
into the cable connector.

Verify the installation position then disconnect the
instrument from the computer or RuggedReader.

Field Deployment

Secure the cable and install the desiccant.

Select a TROLL Com Communication
Device
The subsequent figure shows the function and connection
features of the TROLL Com Communication Device
models.
l

l

A Direct-Connect TROLL Com might be preferred
for programming an instrument that will be deployed
on a suspension cable.
A RuggedCable System and a Cable-Connect
TROLL Com are required if you intend to
communicate with the instrument while it is
deployed. However, you can program the instrument
with any TROLL Com.

3. Hold the textured section of the sleeve in one hand and
the TROLL Com in the other. Push and twist until you
hear a click. The click ensures the cable and TROLL
Com are securely attached.

1

Serial port on a PC/laptop and RuggedReader
Handheld PC

2

Cable-Connect TROLL Com Communication
Device, serial connection, for field use

3

Direct-Connect TROLL Com Communication
Device, serial connection, programming only, not
submersible

4

USB port on a PC/laptop

5

Direct-Connect TROLL Com Communication
Device, USB connection, programming only, not
submersible

6

Cable-Connect TROLL Com Communication
Device, USB connection, for field use

5. Slide the cable sleeve toward the instrument until the pin
on the instrument fits into the hole in the slot on the cable
connector.

6. Hold the textured section of the sleeve in one hand and
the instrument in the other. Push and twist until you hear
a click. The click ensures the cable and instrument are
securely attached.

Program the Instrument
In order to set up a log or download data, you must
connect the instrument to a computer running Win-Situ 5
Software, or a RuggedReader Handheld PC running WinSitu Mobile. Refer to the Win-Situ 5 or Win-Situ Mobile
section. See page 2.

Position the Instrument
Place the instrument at the desired depth. Position the
instrument below the lowest anticipated water level, but
not so low that the pressure sensor range might be
exceeded at the highest anticipated water level. Refer to
the tables below to determine usable depth.
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A BaroTROLL Instrument can be deployed
with a non-vented instrument to compensate
level data for changes in atmospheric
pressure. Make sure the clocks on both
instruments are synchronized, and install the
BaroTROLL in a location that will never be
submerged in water.

Secure the Cable

PSIA

PSIA

kPA

Meters

Feet

30

15.5

106.9

11

35

100

85.5

589.5

60

197

300

285.5

1968

200

658

500

485.5

3347

341

1120

1000

985.5

6795

693

2273

4. Remove the red dust cap from the black nylon cap to
allow air to reach the cable’s vent tube.

1. Remove the protective dust cap from the bottom of the
desiccant pack, if applicable.
2. Remove expiring desiccant (if present) from the cable by
grasping the textured section of the cable connector in
one hand and the desiccant in the other. Twist in
opposite directions to unlock the desiccant from the
cable.

Usable Depth

Effective Range

3. Use the attached hook-and-loop strap to secure the
desiccant to the cable, below the stripped wires.

Installing Desiccant with Twist-Lock
Connectors

Non-Vented Level TROLL Instrument
Range

desiccant to effectively keep cables, instruments, and
electrical boards dry until your next scheduled
maintenance. Desiccant life span is dependent on site
conditions.

3. Attach the new desiccant pack to the twist-lock
connector on the cable.

* Effective range for psia sensors is limited by an estimated 14.5
PSI atmospheric pressure at sea level.

1

Outboard desiccant is attached to the cable
vent tube.

2

Desiccant is secured to the cable with a strap.

Safety
Vented Level TROLL Instrument
Usable Depth

Range

1

Well Dock Installation Ring

2

Kellems Grip

3

Instrument Installed in Well

PSIG

kPA

Meters

Feet

5

34.5

3.5

11.5

15

103.4

11

35

30

206.8

21

69

100

689.5

70

231

Desiccant

300

2068

210

692

500

3447

351

1153

Desiccant protects electronics from condensation, which
can cause irreparable damage and loss of data. Indicating
desiccant changes from blue to pink as it becomes
saturated with moisture.

Verify Instrument Depth
After you have installed the instrument, it is possible to
connect the instrument to a computer or RuggedReader,
open the software, and take a reading to verify the
installation position. If the reading confirms that the
instrument is in the correct position, you can secure it as
described below.
During log setup there was an option to "Remind Me Later"
for setting a level reference. If you set the log to remind you
later, ensure that the instrument is submerged and set the
level reference when prompted.

The instrument complies with all applicable directives
required by CE and the FCC and is found to comply with
EN 61326, ICES-003, and FCC Part 15 specifications.
Declarations of conformity may be found in the Operator's
Manual.

Win-Situ 5 Software
Installing Outboard Desiccant
Vented cable must be installed with outboard desiccant to
protect the cable and instrument electronics from
condensation in high-humidity environments.
The desiccant can be removed from the vent tube, if
necessary, to trim the conductor wires. However, you must
reinstall the desiccant after trimming and connecting the
wires.

Desiccant stages (from left)
New, nearly expired (replace now), expired
It is extremely important to use a properly-sized
desiccant for your deployment and to change desiccant
often. Desiccant should be changed before the entire
volume has turned pink, and you should use enough

1. Cut off the knot at the bottom of the vent tube extension.
2. Firmly attach the vent tube extension to the cable vent
tube. Cover at least 6.4 mm (0.25 in.) of the cable vent
tube for a secure attachment.
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Use Win-Situ 5 with a laptop or a PC and the Aqua
TROLL, Level TROLL and Rugged TROLL Instruments.
To learn more about Win-Situ 5, refer to the Help menu.
Training videos are available on the In-Situ Inc. website
www.in-situ.com under Tech Resources.

Install Win-Situ 5
Insert the software CD that came with your product or
download Win-Situ 5 from the In-Situ website at www.insitu.com/software. Follow the on-screen prompts of the
Installation Wizard to complete installation.
IMPORTANT: Install COM drivers when prompted.

Connecting an Instrument to the Software
When you open Win-Situ 5 Software, you are asked if you
want to connect to your device. Click Yes. Synchronize the

instrument clock to the PC clock.
Parameters and measurements are displayed in light gray
on the home screen if a connection is established. Click
the Play button
to view live readings.
The software displays an error message if a connection
cannot be established.

Selecting the Correct COM Port
If you are using a USB TROLL Com, select the correct
COM port by following the steps below. If you are using a
serial TROLL Com, the Win-Situ Software should default
to the correct COM port, which is usually COM 1.
Steps for Windows 8 systems.
1. Right-click the Start screen.
2. Select All Apps.
3. Click Control Panel.
4. Open the Device Manager.
5. Click the arrow next to Ports (Com and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

4. Click the plus sign next to Ports (COM and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

1. Once you have determined the correct COM port
address in your operating system, reopen Win-Situ 5
Software.
2. Close any open windows in Win-Situ Software.

4. Click Comm Settings, and then click the Port Number
menu.
5. Scroll down to find the correct COM port address. Click
the check mark to accept the changes.

1. Click the Site button.

1. Minimize the Win-Situ Software.
2. Click the Windows Start button, and open the Control
Panel.
3. Double-click the System icon. Click the Hardware tab,
and open the Device Manager.

4. Select the parameters you intend to monitor. You can
rearrange their order and select different units.

6. Configure the logging method.
7. Select a start condition.
When an instrument is deployed on a wire,
rather than a cable, you will not be able to
communicate with it after installation. Select a
Scheduled start if you are deploying an
instrument on a wire.

2. Click the Windows Start button, and open the Control
Panel.

Steps for Windows XP systems.

3. Select your site, and name the new log.

6. Click the yellow Connect button in the lower right corner
5. Select a logging method appropriate for your
to establish a connection to the instrument.
deployment.

Set Up a Data Site

2. Select either Default Site or click the New button to set
up a custom site.
3. Enter a Site Name. Entering coordinates and uploading
a picture are optional.
4. Click the check mark to save the data site.

IMPORTANT: Your instrument MUST be
installed in its final location to set the level
reference correctly. If you are setting up a data
log before installing your instrument in its final
location, you will need to select either “Set First
Logged Reading To” or “Remind Me to Set
Reference Later.”
10. Enter a specific gravity value for the deployment.

2. Click the New button.

3. Click Preferences.

1. Minimize the Win-Situ Software.

4. Click the arrow next to Ports (COM and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

1. Click the Logging tab.

The following steps apply for all Windows
operating systems.

Steps for Windows 7 systems.

3. Click Hardware and Sound, and open the Device
Manager.

Set up a Data Log

8. Select a level reference type.
9. Configure the level reference. Select “Set First Logged
Reading To” if you are using a scheduled start, or
“Remind Me to Set Reference Later” if you are using a
manual start and are NOT deploying the instrument on a
wire.

11. The software displays a summary. Review your
selections carefully before clicking the check mark.
12. Start the log. A Scheduled Start log will start
automatically at its programmed time. To start a Manual
log, go to the Logging tab, highlight the log name, and
tap the Start button.

Real-Time Data Readings
To view real-time data readings, click the Start button on
the Home screen. The parameter readings will turn black
and update periodically. Click the Start button again to
stop reading in real time.
IMPORTANT: You cannot create a new log if you
have real-time readings enabled.

Downloading Data to a PC
This procedure copies the data log from the instrument to
a PC. It does not remove the data log from the instrument.
After a log is downloaded, it can be exported to a CSV file
format that can be used by spreadsheet programs. The
time shown in the log name is the time the log was
downloaded.
1. With an instrument connected, select the Logging tab
.
2. Select the log you intend to download.
3. Choose a Running, Suspended, Stopped, or Deleted
log.
4. Click the Download

button.

5. In the next screen, select one of the three download
options.
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l

All data

Connect to the Software

l

New data (data logged since the last download)

l

Time interval to download

With an instrument connected, tap the Start button on the
RuggedReader. Tap Win-Situ Mobile. Tap the Connect
button, and tap the check mark.

3. At the end of the download, Win-Situ gives you the
option of viewing the data.
l

l

3. Add the log name and tap the right arrow button.
4. Select the parameters you want.

Set up a Data Site
1. Tap the Sites button. Select an existing site or tap the
New button to create a new site.

7. Configure the logging method.

When an instrument is deployed on a wire,
rather than a cable, you will not be able to
communicate with it after installation. Select a
Scheduled start if you are deploying the
instrument on a wire.

Win-Situ Mobile Software

9. Select log wrap condition.
2. Enter information on the subsequent screens and
continue by tapping the right arrow button. Tap the
check mark button when finished.

Set up a Data Log
1. Tap the View menu and select Logging.

2. Communication Cable
3. RuggedCable System
2. Tap the More button, and then tap the New button.

Stop a Log
After you stop a log you cannot restart it.
1. To permanently stop a log that has no scheduled stop,
go to the Logging tab, and select the log.

10. Select a level reference type.

2. Tap the More button, and then tap the Stop button.

11. Enter a specific gravity value for the deployment.

3. Make sure that you download the data after you stop a
log.

12. Configure the level reference. Your instrument MUST be
installed in its final location to set the level reference
correctly. If you are setting up a data log before installing
your instrument in its final location, you will need to select
either “Set First Logged Reading To” or “Remind Me to
Set Reference Later".
Select “Set First Logged Reading To” if you are
using a scheduled start, or “Remind Me to Set
Reference Later” if you are using a manual
start and are NOT deploying the instrument on
a wire.

1. Rugged Reader

4. In-Situ instrument

6. Select a logging method appropriate for your
deployment.

8. Select a start condition.

Select No and the Logging screen appears. You
can view the data at any time by selecting it in the
Data tab.

Connect an Instrument to the Rugged Reader
Serial Port

2. To view the data, tap the View button. Use the View
drop-down menu to select the data channel you want to
view. Select the date and time interval you want and tap
the check mark.

5. Rearrange parameter order if desired. Tap Edit to
change units.

Select Yes and the log is displayed in the Data
screen.

Use Win-Situ Mobile with a RuggedReader Handheld PC
and Aqua TROLL, Level TROLL, and Rugged TROLL
Instruments. Training videos are available on the In-Situ
Inc. website www.in-situ.com under Tech Resources.

View or Download the Log
1. To download data, tap the Logging tab, and tap the
Download button. Select the desired download options
and tap the check mark when finished.

New data is downloaded by default to a new
log file. To append new data to the last
download of this log, be sure the option
"Append logs on download" is selected in the
General Settings dialog (Preferences >
General Settings).
2. The log is copied to the connected PC into your Win-Situ
working directory folder. View or change the working
directory using File > Settings.

log, go to the Logging tab, highlight the log name, and
tap the Start button.

13. The software displays a summary. Look over your
selections carefully before clicking the check mark.
14. Start the log. A Scheduled Start log will start
automatically at its programmed time. To start a Manual
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Drop the Connection and Exit Win-Situ Mobile
Software
Prior to physically disconnecting the RuggedReader from
the communication cable, tap the Connect button. The
button changes from blue to yellow and appears
disconnected.
To exit Win-Situ Mobile Software, tap the File menu and
select Exit.

